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What is VarTran? 
 
VarTran is in one sense a tolerancing package.  It can perform all the standard analysis including 
statistical tolerancing, worst-case tolerancing, and sensitivity analysis.  But VarTran goes beyond the 
bounds of traditional tolerancing packages to address the selection of optimal targets for the inputs.  
This also makes VarTran a product/process optimization tool.  In finding the optimal targets, VarTran 
considers the effects of the inputs on both the average and variation of the outputs resulting in a robust 
design.  VarTran is also a robust design tool.  Below are just some of VarTran’s capabilities: 
 

♦ Optimize product or process performance: 
♦ Maximize Cpk

♦ Minimize percent defective 
♦ Minimize Taguchi loss 

♦ Achieve robust designs 
♦ Statistical tolerancing 
♦ Worst-case tolerancing 
♦ Process tolerancing (a unified approach to tolerancing) 
♦ Find cause of variation (sensitivity analysis) 
♦ Handles tough nonlinear problems 
♦ Analytic methods of predicting variation that are much faster 

than performing simulations 
♦ Optimization routines based on interval analysis that are 

guaranteed to find the global optimal 
♦ Following designed experiments, use to: 

♦ Optimize for production conditions rather than the 
conditions existing during the study 

♦ Identify the root cause of the variation 
 
State of the Art Capabilities 
 
VarTran has many firsts.  It introduces a unified approach to tolerancing called process tolerancing that 
incorporates both statistical and worst-case tolerancing.  This allows statistical and worst-case 
tolerances to be mixed in the same analysis.  It uses interval analysis optimization routines guaranteed 
of finding the global optimal.  It uses analytic methods of predicting the variation, which are much 
faster than performing simulations.  With VarTran, you can accomplish feats you never before 
dreamed of. 
 
Trial Period 
 
The downloaded software is the full version of VarTran but is limited to a 30-day trial period.  At the 
end of this trial period, the functionality of the software is severely reduced.  After the 30-day trial 
period, the program is limited to running previously created problems or problems restricted to a small 
number of variables.  VarTran runs under any 32-bit version of Windows including Windows 95, 
Windows 98, Windows 2000, Windows XP and Windows NT. 
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After the trial period, the software can be restored to full functionality by registering the software at 
www.variation.com/vta and paying the $495 registration fee (subject to change).  You will then be 
provided with a registration code that will restore it to full functionality. 
 
Further information is available from: 
 
 Taylor Enterprise, Inc. 
 5510 Fairmont Rd., Suite A 
 Libertyville, IL 60048  USA 
  

 Phone: (847) 367-1032 
 Fax: (847) 367-1037 
 E-mail: info@variation.com 
 Web Site: www.variation.com 
 
Getting Started 

 
First download the file vta31.exe from www.variation.com/vta.  Executing this file will install the 
software.  It can be uninstalled at any time using the Windows control panel. 
 
To get a quick understanding of the software’s capability, select the tutorial below of greatest interest 
and turn to that section for step by step instructions. 
 

Design of a Pump:  Demonstrates the use of VarTran in product development. 
 

Optimization of a Heat Sealer:  Demonstrates the use of VarTran on a process 
following a response surface study. 

 
Dimensional Stack-up Problem:  Demonstrates the variety of methods available in 
VarTran for addressing tolerance stack-up problems. 

 
VarTran as a Mathematics Package:  Demonstrates VarTran's math capabilities 
including its state-of-the-art optimization routines based on interval analysis. 

 
Once acquainted with the software, you can try your own problem, as described in the last section, or 
you can explore some of the more advanced features of the software.  Further information is readily 
available through VarTran's extensive help system and user manual. 
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TUTORIAL 1: DESIGN OF A PUMP 
 
1.1 Introduction 
 
Design offers the first and best opportunity for reducing variation.  To illustrate the strategies and tools 
required, consider the task of designing a new pump.  Suppose that the pump must be capable of 
delivering solution at a constant rate of 10 ml/min.  Customer usage requires that the flow rate remain 
between 9 and 11 ml/min.  The first step is to develop a design concept.  Taguchi calls this the system 
design.  Suppose we decide to use a piston to push the solution.  This concept requires a motor to drive 
the piston and a valve to control the direction of the flow.  This is the creative part of design. 
 
Now the work begins.  We need to determine all the specifics such as "How far should the piston 
travel?" and "How fast should the motor turn?"  To accomplish this task, we need to make a list of all 
the factors affecting flow rate.  Three obvious factors are the piston radius (R), the stroke length (L), 
and the motor speed (S).  Another possible factor is the amount of backflow through the valves (B).  
Factors affecting flow rate are referred to as the input variables.  Flow rate is referred to as the output 
variable.  It is the output for which we want to optimize the average and reduce the variation.  This is 
accomplished by establishing requirements and controls for the inputs. 
 
1.2 Initial Design 
 
To accomplish our task, we must be able to predict how the output will behave.  This requires 
knowledge of how the inputs behave and how the inputs affect the output.  For a pump, it is possible to 
use geometry to derive the following equation for flow rate: 
 

F = (16.388 π R2 L - B) S 
 

The expression π R2 L represents the volume of a cylinder of radius R and height L.  Multiplying by 
16.388 converts the quantity from cubic inches to milliliters.  The volume is then reduced by the 
backflow and multiplied by the motor speed to obtain the final flow rate. 
 
We also need information on how the inputs behave.  This requires us to call the plant to obtain 
process capability information on drilling the piston hole.  They tell us the standard deviation of their 
process is 0.0005".  We must also call the motor supplier to determine the capability of their process in 
controlling motor rpm.  They have both $5 and $20 motors.  Our initial design will be based on low-
cost components and processes so we request information on the $5 motor.  Changes can be made later 
if necessary.    They inform us that the standard deviation of their process is 0.17 rpm.  The valve 
supplier must also be contacted to determine their process capability information for valve backflow.  
There is a choice between a $1 and a $2 valve.  Again we start with the $1 valve.  The valve 
manufacturer provides us with both an average and standard deviation.  The table on the next page 
shows the information collected. 
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Data from Plants and Suppliers 
 

Inputs Average Standard Deviation 
Piston Radius (R) - 0.0005” 

Stroke Length (L) - 0.0017” 

Motor Speed (S) - 0.17 rpm 

Backflow (B) 0.05 ml 0.005 ml 
 
Targets must be selected for piston radius, stroke length and motor speed.  Values of R = 0.1" and L = 
0.5" were selected based on judgment.  Plugging these values into the equation for flow rate, setting 
the equation equal to 10 ml/min and solving for motor speed results in a motor speed of 48.2 rpm.  
This completes the preliminary design.  The average should be on target, but what about the variation? 
 
1.3 Using VarTran 
 
For a demonstration of VarTran's abilities, start VarTran and open the file pump.vta.  This is 
accomplished by selecting the Open... menu item from the File menu.  Highlight pump.vta and then 
click on the OK button.  The I/O System window shown below will be displayed.  The input variables 
are shown on the left of the window and the output variables are shown on the right. 
 

 
 
All of the information about the input and output variables has already been entered into VarTran.  To 
view the information entered for a variable, double click on it in the I/O System window.  For example, 
double clicking on the output variable F displays the dialog box shown on the next page.  This dialog 
box is used to enter the equation, target and specification limits for flow rate.  Press the OK button to 
close the dialog box. 
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Try the same for the input variable R.  The dialog box shown below is displayed.  This dialog box is 
used to enter the target and standard deviation for R.  A tolerance has been entered that is +/-3 standard 
deviations.  The standard deviation is then specified as 1/6 the width of the tolerance.  A maximum and 
minimum target has also been entered representing the range of alternative targets considered when 
optimizing the design later.  The Include in Optimization check box is checked indicating that the 
target for this input can be changed during design optimization.  Press the OK button to close the 
dialog box. 
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For input variable B (valve backflow), the Include in Optimization check box is not checked.  This 
prevents the backflow target from changing during optimization.  The target for backflow was 
provided by the supplier and cannot be adjusted by the designer. 
 
1.4 Evaluating the Initial Design 
 
If you know how the inputs behave and you know how the inputs affect the output, you can predict 
how the output will behave.  While this can be accomplished using a simulation, VarTran uses analytic 
methods instead.  To view the results, click on the Capability Study button on the toolbar.  This 
performs a tolerance analysis and displays the results shown below. 
 

 Analysis – Capability Study 
 

 
 
In designing this pump, our goal is six sigma quality.  This requires a defect rate of 3.4 defects per 
million (dpm) or below.  The capability study predicts that the defect rate will be 297 dpm and that 
some pumps will have flow rates as low as 8.7544 and as high as 11.242 ml/min.  Both these values 
are outside the specifications of 9 to 11 ml/min.  The initial design does not achieve our six sigma goal.  
Since the flow rate average is on target, the variation must be reduced.  Leave the Capability Study 
window open. 
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1.5 Robust Design 
 
One way of reducing the flow rate variation is through what Taguchi calls robustness.  Robustness is 
obtained by designing the pump to be less sensitive to the variation of the inputs.  The inputs continue 
to vary, but less of this variation is transmitted to the output.  Robust design is accomplished through 
the setting of the inputs' targets.  Since it is generally less costly to adjust targets than tighten 
tolerances, building in robustness is the preferred method of reducing variation.  This is what Taguchi 
calls the second stage of design, which he refers to as Parameter Design. 
 
A robust design can be obtained by finding the set of targets for the inputs that minimizes the defect 
rate.  Start by clicking on the Optimize button on the toolbar.  The Find Optimal Targets dialog box 
shown below is displayed.  Specify that the flow rate percent defective is to be minimized and then 
click on the Simplex Optimize button.  The optimization will take just a couple of seconds. 
 

 Analysis – Find Optimal Targets 
 

 
 
Once the optimization is completed, exit the Find Optimal Targets dialog box by clicking on the Close 
button.  The Capability Study window will automatically update itself.  It will now appear as shown on 
the next page.  The variation has been cut in half while maintaining an average flow rate of 10 ml/sec.  
Since the defect rate is below 3.4 dpm, our design is now six sigma.  The capability study predicts that 
nearly all units will fall in the range of 9.3224 to 10.678 ml/min.  This is well within the specification 
limits.  All this was accomplished using the low cost components.  Your results may differ slightly due 
to the properties of the optimization routine but should be very close. 
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To view the new design, click on the Summary Table button on the toolbar.  The result is shown below.  
The new targets are R = 0.1737", L = 0.40942" and S = 17.064 rpm.  The target for valve backflow did 
not change because it was excluded from the optimization.  It was provided by the supplier and cannot 
be adjusted by the designer. 
 

 Variables – Summary Tables 
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1.6 Tightening Tolerances 
 
What if the desired performance had not been achieved?  The next step would be to tighten tolerances.  
This generally requires using more expensive components and processes.  The question is which 
tolerances and by how much?  In deciding which tolerances to tighten, you should consider both the 
cost and the effect of tightening each tolerance.  To determine the effect of tightening the tolerances on 
the different inputs, click on the Variation Pareto Chart button on the toolbar.  The window shown 
below is displayed. 
 

 Analysis- Variation Pareto Chart 
 

 
 
Motor speed variation (S) is the largest contributor to the flow rate variation.  Tightening its tolerance 
requires using the $20 motor.  One could enter the tolerance (standard deviation) for the $20 motor, re-
optimize the process and then view the new capability.  One should also consider tightening the 
tolerance for valve backflow.  This requires using the $2 valve which is significantly cheaper.  The 
Pareto chart indicates the effect is nearly the same as tightening the tolerance of motor speed.  The 
option representing the best value to the customer should be selected.  This is what Taguchi refers to as 
the third stage of design, which he calls Tolerance Design. 
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1.7 Summary 
 
The above example illustrates the following strategies: 

 
(1) The designer must take the time to identify: 
 

• The key outputs 
• Customer requirements for the key outputs 
• The key inputs 
• How the key inputs behave (manufacturing and suppliers capabilities) 
• How the key inputs affect the outputs (equations) 

 
Without this knowledge, the design process breaks down into one of trial and error. 

 
(2) Designing in robustness results in higher quality and lower costs.  Otherwise, variation 

must be reduced by tightening tolerances which drives up costs.  This requires that variation 
be considered when determining the inputs' targets. 

 
(3) The initial design should be based on low-cost tolerances.  This ensures manufacturability 

of the product.  Tolerances are selectively tightened only if needed.  Instead designers 
frequently specify overly tight tolerances for the inputs to insure design performance which 
in turn drives up costs. 
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TUTORIAL 2: OPTIMIZATION OF A HEAT SEALER 
 
2.1 Introduction 
 
A heat sealer is used to form the top seal of a pouch used to protect the product.  The top seal must be 
strong enough to withstand shipping and handling but weak enough to be easily opened by the 
customer.  The target seal strength is 26 pounds with specification limits of 20 to 32 pounds. 
 
A response surface study was run to optimize the performance of the heat sealer.  Eight inputs 
variables were studied.  Of these, hot bar temperature, dwell time, pressure and material temperature 
were found to have significant effects on the inputs.  The seal strength standard deviation was analyzed 
separately.  Two of these inputs, hot bar temperature and dwell time, were also found to affect the seal 
strength standard deviation.  Contour plots were then used to identify the input targets minimizing the 
variation and achieving an average seal strength of 26 pounds.  Selecting targets for the inputs that 
minimize the seal strength variation is called a robust process.  This approach is called the dual 
response (average and standard deviation) approach to robustness. 
 
Studies like the one above have proven highly successful.  However, such studies also have their 
limitations.  First, the dual response approach to robustness optimizes the process performance under 
the conditions that were present when the study was run.  Frequently, the variation present during the 
study is not representative of the full range of variation that will be experienced over more extended 
periods of production.  For example, if only one roll of plastic sheeting is used in the study, roll-to-roll 
variation of sheeting thickness would not be captured as part of the variation.  This can result in 
making the process robust to the wrong sources of variation. 
 
Taguchi suggest an alternative approach called the inner/outer array approach that overcomes this 
limitation.  His outer array corresponds to the design array of the response surface study.  He suggests 
that for each trial in the outer array, those inputs potentially contributing to the variation be purposely 
varied in a pattern that mimics their variation in production.  This pattern is called the inner or noise 
array.  This approach increases the costs of performing the study but ensures the process is optimized 
for production conditions.  Using VarTran, the process can be optimized for actual production 
conditions without the added expense of running an inner/outer array type study. 
 
The second limitation of the dual response approach is that it does not identify the root cause of the 
variation.  If adjusting targets fails to obtain the desired performance, further reduction in the variation 
must be achieved by tightening the tolerances of the inputs.  However, it is not known which 
tolerances to tighten.  VarTran can be used to identify the root cause of the variation allowing further 
reduction of the variation through the tightening of tolerances.  The following tutorial shows how 
VarTran can be used to overcome both these limitations. 
 
2.2 Response Surface / Tolerance Analysis Approach 
 
The first step using this approach is to run a response surface study.  The purpose of this response 
surface study is to obtain an equation for how the inputs affect the output.  The equation shown below 
was obtained: 
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SS  = 27.9029646803808 + 0.0822867601868433 (THB - 175) - 9.00263649461868 (DT - 0.75)  
+ 0.0458833145964137 (P - 100) + 0.0430545023685393 (MT - 90)  
- 0.00749437527699365 (THB - 175)2 - 83.3209058456264 (DT - 0.75)2  
- 1.03469576191631 (THB - 175) (DT - 0.75) 

 

where SS = seal strength, THB = temperature of the hot bar, D = dwell time, P = pressure and MT = 
material temperature.  This equation is for the average seal strength. 
 
We also need information on how the inputs behave.  This requires collecting additional data from the 
process.  To obtain information on temperature of the hot bar, a temperature transducer was attached to 
the hot bar and the results recorded over an extended production run.  From this data the standard 
deviation of the hot bar temperature was estimated.  Likewise, standard deviations for the other inputs 
were also obtained.  These standard deviations should be representative of long term production.  The 
results are shown below.  Also displayed are the targets for the inputs that are used in production. 
 

Data on the Behavior of the Inputs 
 

Inputs Average Standard Deviation 
Temperature of the Hot Bar (THB) 190 ºF 2 ºF 

Dwell Time (D) 0.8 sec 0.08 sec 

Pressure (P) 100 lbs 1 lbs 

Material Temperature (MT) 75 ºF 4 ºF 

 
We are now ready to perform a tolerance analysis using VarTran.  For a demonstration of VarTran's 
abilities, start VarTran and open the file heatseal.vta.  This is accomplished by selecting the Open... 
menu item from the File menu.  Highlight heatseal.vta and then click on the OK button.  The I/O 
System window below is displayed showing the inputs and outputs.  The inputs are displayed on the 
left followed by the outputs on the right. 
 

 
 
To view the information entered for a variable, double click on it in the I/O System window.  For 
example, double clicking on the output SS displays the dialog box on the next page.  This dialog box is 
used to enter the equation from the response surface study along with the target and specification 
limits.  Press the OK button to close the dialog box. 
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Try the same for temperature of the hot bar.  The dialog box shown below is displayed.  The standard 
deviation is 2ºF.  This standard deviation represents the full variation expected during production.  A 
tolerance has been entered that is +/-3 standard deviations.  The standard deviation is then specified as 
1/6 the width of the tolerance.  The minimum and maximum targets have been set to the response 
surfaces region of study.  This avoids extrapolation by restricting the range of alternative targets 
considered when the process is later optimized to the region of study.  The target is initially set to the 
production target.  It will change later when the process is optimized.  The Include in Optimization 
check box is checked signifying that the target for this input can be changed during optimization.  
Click the OK button to close the dialog box. 
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2.3 Predicting Seal Strength Variation 
 
If you know how the inputs behave and you know how the inputs affect the output, you can predict 
how the output will behave.  While this can be accomplished using a simulation, VarTran uses analytic 
methods instead.  To view the predicted results at the original operating conditions, click on the 
Capability Study button on the toolbar.  The predicted performance is shown below. 
 

 Analysis – Capability Study 
 

 
 
The predicted performance is far from that desired.  The process is only slightly off target.  The most 
significant issue is the excessive variation.  Leave the Capability Study window open. 
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2.4 Optimizing Seal Strength to Achieve Robustness 
 
One way of reducing the seal strength variation is through what Taguchi calls robustness.  Robustness 
is obtained by setting up the heat sealer to be less sensitive to the variation of the inputs (both process 
parameters and material properties).  The inputs continue to vary, but less of this variation is 
transmitted to the output.  Robust design is accomplished through the setting of the inputs' targets.  
Since it is generally less costly to adjust targets than tighten tolerances, robustness is the preferred 
method of reducing variation. 
 
A robust process can be obtained by finding the set of targets for the inputs that minimizes the defect 
rate.  Start by clicking on the Optimize button on the toolbar.  The Find Optimal Targets dialog box 
shown below is displayed.  Specify that the seal strength percent defective is to be minimized and then 
click on the Simplex Optimize button.  The optimization will take just a couple of seconds. 
 

 Analysis – Find Optimal Targets 
 

 
 
Once the optimization is completed, exit the Find Optimal Targets dialog box by clicking on the Close 
button.  The capability study is automatically updated.  It will now appear as shown on the next page.  
The variation has been cut by 70% while achieving an average seal strength of 26 pounds.  The 
predicted defect rate is well below 1 dpm (defects per million).  The capability study predicts that 
nearly all units will fall in the range of 22.429 and 29.571 pounds.  This is well within the specification 
limits.  All this was accomplished by adjusting the targets at which the process is operated.  This 
simply requires adjusting a few knobs.  No tolerances were tightened. 
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To view the targets selected for the inputs, click on the Summary Tables button on the toolbar.  The 
result is shown below.  The new targets are a hot bar temperature of 191ºF, a dwell time of 0.596 
seconds and a pressure of 55.28 pounds.  Material temperature remains at 75ºF.  Material temperature 
did not change because its Include in Optimizations check box was not checked.  The optimization 
determined: "Without preheating of the material, what is the best setup?"  Since the process safely fits 
between the specification limits, preheating of the material is not necessary. 
 

 Variables – Summary Tables 
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2.5 Cause of the Variation 
 
We have still not answered the question of what is causing the variation.  This is especially important 
when the desired objective has not been achieved.  The answer can be obtained by clicking on the 
Variation Pareto Chart button on the toolbar.  The results are shown below.  Dwell time variation 
turns out to be the largest source of variation.  Using VarTran, one could enter a new tolerance for 
dwell time, re-optimize the process and then view the new predicted capability. 
 

 Analysis- Variation Pareto Chart 
 

 
 
2.6 Summary 
 
The above example illustrates that VarTran can be used to: 
 

(1) Optimize the process for production rather than study conditions. 
 

(2) Identify the root cause of the variation. 
 

(3) Be used to tighten tolerances to achieve the desired performance even when the response 
surface fails to find targets that achieve the desired result. 

 
Any time a response surface study is run, one should use VarTran to complete the task of establishing 
operating windows. 
 
The response surface/tolerance analysis approach to robustness offers a third alternative to the dual 
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response and Taguchi inner/outer array approaches.  The response surface/tolerance analysis approach 
has all the advantages of Taguchi’s approach without the added cost of running a more complex study.  
It also has another significant advantage over both the dual response and Taguchi approaches.  The 
estimates of the variation resulting from the response surface/tolerance analysis approach are generally 
more accurate and precise than estimates resulting from the other two approaches.  The response 
surface/tolerance analysis approach is the best demonstrated practice for achieving robustness. 
 
The response surface study is only required if an equation is not otherwise available.  If the equation is 
already known, VarTran can be used directly.  For the infamous Wheatstone bridge example used by 
Taguchi, the equation was first derived.  This equation can be entered directly into VarTran and the 
problem solved within minutes without needing a designed experiment. 
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TUTORIAL 3: DIMENSIONAL STACK-UP PROBLEM 
 
3.1 Introduction 
 
Suppose that four identical components are to be stacked on top of each other and that we are 
interested in controlling the overall height.  The height will be denoted by the symbol H and will be 
referred to as the output variable.  We desire an overall height of 4.0".  The customer will not tolerant a 
deviation from target of more than ± 0.1".  This results in a lower specification limit of 3.9" and an 
upper specification limit of 4.1". 
 
The four components are identical.  Their manufacturing tolerance is 1.00" ± 0.03" or stated another 
way from 0.97" to 1.03".  Essentially all components fall within these tolerances.  The heights of the 
four components will be denoted D1, D2, D3 and D4 and will be referred to as the inputs.  The overall 
height is equal to: 
 

 H = D1 + D2 + D3 + D4 
 

The question we want to answer is whether the overall height requirement will be met.  There are 
several different approaches to answering this question.  These are illustrated below. 
 
3.2 Worst-case Tolerancing Approach 
 
One commonly used approach is called worst-case tolerancing.  For a demonstration of VarTran's 
abilities in calculating worst-case tolerances, start VarTran and open the file stack-wc.vta.  This is 
accomplished by selecting the Open... menu item from the File menu.  Highlight stack-wc.vta and then 
click on the OK button.  The results of a worst-case tolerance analysis are displayed below. 
 

Overall Height - (H)
Worst-Case Tolerance

3.88 4.12inches

TLSL USL

Characteristic Value
At Target: 4
Minimum: 3.88
Maximum: 4.12

Interval for Values = (3.88, 4.12)  
 
The resulting worst-case tolerance for overall height is from 3.88" to 4.12".  This fails to meet the 
specification limits for the overall height.  As a result, tolerances for the inputs must be tightened if the 
specification limits for overall height are to be met. 
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Worst-case tolerancing assumes that all four components can simultaneously be at the same extreme 
value.  For example, if all four components have the minimum height of 0.97", the overall height will 
be 3.88".  Likewise, if all four components have the maximum height of 1.03", the overall height will 
be 4.12".  This yields a worst-case tolerance for overall height of 3.88" to 4.12".  If the tolerances for 
the individual components are all met, the resulting worst-case tolerance for overall height is 
guaranteed to be met. 
 
To view the information that was entered into VarTran, double click on the different variables in the 
I/O System window shown below. 
 

 
 
For example, double clicking on input D1 displays the dialog box shown below.  This dialog box 
contains the target and worst-case tolerance for D1.  To close the dialog box, press the OK button. 
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Double clicking on overall height, displays the dialog box shown below.  This dialog box contains the 
equation for overall height along with its target and specification limits.  Again, press the OK button to 
close the dialog box. 
 

 
 
3.3 Statistical Tolerancing Approach 
 
A second commonly used approach is called statistical tolerancing.  The results of a statistical 
tolerance analysis can be displayed by opening the file stack-st.vta.  The results are shown below. 
 

Overall Height - (H)
Statistical Tolerance

3.9 4.1inches

TLSL USL

Characteristic Value
Average: 4
Standard Deviation: 0.02
Cp: 1.67
Cc: 0.00
Cpk: 1.67
Def. Rate (normal): 0.573 dpm
Z-Score (short-term): 4.86
Sigma Level: 4.86

 Interval for Values = (3.94, 4.06) +/-3SD  
 
The resulting statistical tolerance for overall height is from 3.94" to 4.06".  This easily meets the 
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specification limits.  The tolerance for the components does not require tightening.  Statistical 
tolerancing results in the opposite conclusion as worst-case tolerancing. 
 
Statistical tolerancing assumes that the components come from a process that is centered on the target 
and that traditionally has a maximum standard deviation equal to 1/6 the tolerance.  In this case, the 
tolerance of ± 0.03" results in a maximum standard deviation of 0.01".  For tolerance stack-up 
problems, statistical tolerances are obtained by using the root sum of squares formula.  In this case, the 
resulting tolerance for overall height is: 
 
 06.003.003.003.003.0 2222 =+++  
 
The resulting statistical tolerance of 4.0" ± 0.06" is exactly half that of the worst-case tolerance. 
 
To view how the information entered for input D1 has changed, double click on D1 in the I/O System 
window.  The dialog box shown below will appear.  This dialog box contains the target and tolerance 
of D1.  In the standard deviation field, the standard deviation is defined to be 1/6 the width of the 
tolerance.  To close the dialog box, press the OK button. 
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3.4 Statistical Versus Worst-case Tolerances 
 
The dilemma faced when tolerancing is which approach to tolerancing should be used.  As the above 
example illustrates, the approach selected can make a large difference.  So what are the pros and cons? 
 
Worst-case tolerancing is a safe approach.  If the 4 components all meet their tolerances, the overall 
height is guaranteed to be within the calculated worst-case tolerance.  However, worst-case tolerancing 
guards against the unlikely event where all four components are simultaneously at the same extreme, 
either all at the lower tolerance value or all at the upper tolerance value.  This is unlikely in any case.  
However, it is especially unlikely if the components come from a process with variation.  When 
variation is present, the average height of the components must be safely within the tolerance limits to 
ensure that the individual components all remain within the tolerances.  As a result, only a small 
number of components are actually at the extreme value.  The probability of selecting four components 
all at the same extreme is therefore extremely small. 
 
Worst-case tolerancing guards against a worst-case scenario that can only occur if the variation is zero.  
As a result, worst-case tolerances for the output are wider than will be experienced in practice.  This 
can result in the unnecessary tightening of tolerances for the components driving up costs.  Worst-case 
tolerancing, while safe, is overly expensive. 
 
Statistical tolerancing results in much narrower tolerances for the outputs.  As a result, the tolerances 
for the inputs do not require as much tightening resulting in lower costs.  However, there is a risk 
involved.   Statistical tolerancing assumes that the process producing the components remains centered 
at the selected target.  No process remains perfectly centered all the time.  With statistical tolerancing, 
off center processes can result in components that meet the tolerance for the individual components 
but, when assembled together into a finished unit, result in a finished unit that exceeds specifications.  
As a result, statistical tolerances for the output can be narrower than will be experienced in practice.  
As such, statistical tolerancing might be better called best-case tolerancing.  Statistical tolerancing, 
while less expensive, is more risky.  The real answer generally falls somewhere between the worst-
case and statistical approaches. 
 
This long recognized dilemma has lead to a number of less than ideal practices.  One approach used is 
called Benderizing tolerances.  It basically is to do statistical tolerancing and then inflate the resulting 
tolerance by 50%.  Another approach is to split the difference.  This approach involves doing both 
worst-case and statistical stack-ups and taking the midpoint between them.  As unscientific as either of 
these approaches sounds, both are probably closer to the correct answer than either the worst-case or 
the statistical stack-up. 
 
3.5 A Solution - Process Tolerancing 
 
Worst-case tolerances results in tolerances for the outputs that are too wide.  It is safe but expensive.  
Statistical tolerancing results in tolerances for the outputs that are too narrow.  It is less expensive but 
risky.  Ideally we want to be somewhere between these two extremes.  A new method of tolerancing 
called process tolerancing has been implemented in VarTran that allows just this. 
 
The results of a process tolerance analysis can be displayed by opening the file stack-pr.vta.  The 
results are shown below. 
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Overall Height - (H)
Process Tolerance

3.9 4.1inches

TLSL USL

Characteristic On-Target Worst-Case
Average - Minimum: 4 3.96

Maximum: 4.04
Standard Deviation: 0.013333 0.013333
Cp: 2.50 2.50
Cc: 0.00 0.40
Cpk: 2.50 1.50
Def. Rate (normal): 6.38 10 -̂8 dpm 3.37 dpm
Z-Score: 7.41 4.50
Sigma Level: 7.41 6.00

Interval for Values = (3.92, 4.08) +/-3SD  
 
The resulting process tolerance calculated for overall height is from 3.92" to 4.08".  This meets the 
specification limits for overall height.  The process tolerance falls between the worst-case and 
statistical tolerances and is more representative of what will actually occur in production. 
 
Process tolerances are obtained by specifying requirements for the processes that produce the 
components rather than for the individual components.   Process tolerances are specified by giving a 
minimum average, a maximum average and a maximum standard deviation.  They do not assume that 
the standard deviation is zero nor do they assume that the process is perfectly centered.  To see how a 
process tolerance was specified for D1, click on D1 in the I/O System window.  The dialog box shown 
below is displayed. 
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In the example above, it was specified that the average height must be in the range 1" ± 0.01".  It was 
also specified that the standard deviation must be less than or equal to 0.006667".  This was done by 
specifying a standard deviation equal to 1/9 the width of the tolerance and an operating window for the 
average of ± 1.5 standard deviations.  The three normal curves in the graphic represent the minimum 
average, on-target average and maximum average all with the maximum standard deviation.  This 
results in the same overall tolerance for the individual components as before, namely 1.00" ± 0.03". 
 
For the specified process tolerances for the individual components, it can be determined that the 
average overall height will remain between 3.96" and 4.04" and that the standard deviation for overall 
height will be at or below 0.013333".  Extending the interval for the average 3 standard deviations in 
either direction results in the tolerance for overall height of 3.92" to 4.08".  So long as the processes 
producing the components meet the process tolerance, overall height is guaranteed to be within the 
specification limits.  This falls between the 4 ± 0.12 from worst-case tolerancing and 4 ± 0.06 from 
statistical tolerancing.  Like worst-case tolerancing, process tolerancing is safe.  However, process 
tolerancing is much less expensive. 
 
3.6 A Unified Approach to Tolerancing 
 
Process tolerancing is much more than simply a third approach to tolerancing.  It represents a unified 
approach to tolerancing that combines both of the previous approaches.  Worst-case tolerances are 
special cases of process tolerances where the standard deviation is zero.  Statistical tolerances are 
special cases of process tolerances where the minimum average and maximum average are set equal to 
the target.  Neither of these two special cases is very realistic.  Using process tolerances, you are no 
longer forced to make a choice between worst-case tolerances with its increased costs or statistical 
tolerances with its increased risks. 
 
With VarTran you can also use a combination of all three approaches.  You can specify worst-case 
tolerances for environmental variables and usage conditions over which you have no control.  You can 
specify statistical tolerances for machine parameters that are controlled using automatic controllers to 
ensure they remain centered.  You can also specify process tolerances for components from a supplier 
where you can not guarantee that the process remains perfectly centered.  With VarTran, you can 
choose the appropriate type of tolerance for each input.  No longer are you forced to treat all inputs the 
same. 
 
VarTran is not restricted to performing tolerancing on just stack-up problems.  It can perform all three 
methods of tolerancing for any equation, including complex nonlinear equations.  This allows one to 
perform tolerancing on problems impossible to solve by hand and for which the tolerance stack-up 
formulas do not apply.  The pump and heat seal tutorials serve as two examples. 
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TUTORIAL 4: VARTRAN AS A MATHEMATICS PACKAGE 

 
For a demonstration of VarTran's mathematical capabilities, start VarTran and open the file math.vta.  
This is accomplished by selecting the Open... menu item from the File menu.  Highlight math.vta and 
then click on the OK button. 
 
The I/O System window shown below is displayed.  There is one output variable f shown on the right 
of the window.  The output is the function of two inputs variables x and y.  These are shown on the left 
of the window.  This represents a function f in two parameters x and y. 
 

 
 
The equation for f is shown below.  This dialog box is displayed by double clicking on the box labeled 
f in the previous window.  Close this dialog box by pressing the OK button. 
 

 
 
In tolerance analysis, inputs have behaviors described by the tolerances selected.  These tolerances 
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describe a range of possible values.  In a mathematical analysis, inputs have a single value.  This can 
be represented in VarTran by a worst-case tolerance of width zero as shown below.  To display this 
dialog box, double click on x in the I/O System window. 
 

 
 
The values of the inputs can be viewed in the Summary Tables window.  Initially both values are set to 
zero. 
 

 Variables – Summary Tables 
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When constant values are entered for the inputs, performing a capability study amounts to evaluating 
the function.  To display a capability study, double click on the Capability Study button on the toolbar.  
When x and y are zero, the function is equal to 1.  Leave the Capability Study window open. 
 

 Analysis – Capability Study 
 

 
 
VarTran can be used to obtain line, interaction and contour plots of this function.  One such contour 
plot is shown below.  This contour plot shows that this function has numerous local minimums and 
maximums. 
 

f - Value
1

0

-1

y

-1 0 1
x

f - Value = 4
f - Value = 3.3333
f - Value = 2.6667
f - Value = 2
f - Value = 1.3333
f - Value = 0.66667
f - Value = 6.6613 10 -̂16
f - Value = -0.66667
f - Value = -1.3333
f - Value = -2

 
 
To generate your own plots, click on the Plot button on the toolbar.  This displays the Plots dialog box 
shown on the next page.  Try selecting the different types of plots.  To copy a plot to a separate 
window, click on the Window button.  Close the dialog box by pressing the Close button. 
 

29 
 



 Analysis - Plots 
 

 
 
To find the maximum and minimum values of f, click on the Find Optimal Targets button on the 
toolbar.  This displays the Find Optimal Targets dialog box shown below.  Initially, this dialog box is 
set to maximize the value of f.  Click on the Optimize Using Interval button to start the optimization. 
 

 Analysis – Find Optimal Targets 
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Once the optimization is completed, close the dialog box by clicking the Close button.  The maximum 
value will now appear in the Capability Study window.  The settings of the inputs that result in the 
maximum are displayed in the Summary Tables window.  If a red X appears in these windows, click on 
them to update them.  The function f is maximized when x=0.9082 and y=-0.73633.  Its maximum 
value is 4.0619.  Try resetting the inputs and repeating the optimization.  You get the same answer 
every time.  The Interval optimization routine is never fooled by local maximums. 

       
 
Try minimizing f as well.  The function f is minimized when x=0.48828 and y=0.71094.  Its minimum 
value is -2.2202.  Try repeating the optimization.  Again, the optimization routine is never fooled by 
local minimums.  Most optimization routines have difficulties with functions containing local 
minimums and maximums. 

       
 
VarTran has extensive mathematical capabilities including a novel new method of optimization based 
on interval analysis.  However, it differs from traditional math packages in the way that it handles the 
input variables.  In most math packages, input variables represent values.  These values are used to 
calculate the value of the function (output variable).  In VarTran, the input variables represent 
behaviors.  For example, an input variable might be assigned a statistical distribution (statistical 
tolerance) or an interval that its value must fall within (worst-case tolerance).  VarTran then determines 
how the function or output variable will behave.  When dealing with products and processes, this 
represents the difference between how the product or process performs in theory (value) versus how it 
will perform in practice (behavior). 
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SECTION 5: WORKING YOUR OWN PROBLEM 
 
You can also work a problem of your own.  Begin by starting VarTran.  Initially there are no inputs or 
outputs.  Begin by adding the variables.  Variables are added by pressing the Add button on the toolbar.  
This displays a popup menu for selecting the type of variable as shown below.  Selecting a type of 
variable displays the appropriate dialog box for entering further information. 
 

 
 
You repeat this process for each variable to be added.  For each variable, you must enter a symbol.  
The symbol should be short, typically 1-3 letters.  Watch the status line at the bottom of the window 
for error messages.  Once the message "I/O System complete" is displayed, the different analyses can 
be performed.  Further details are available through the help system.  The index to the help system can 
be displayed by selecting the Index... menu item from the Help menu.  All dialog boxes have a help 
button for obtaining help on using the dialog box. 
 
A couple of pointers:  Holding the mouse cursor over the top of a button on the toolbar displays a 
description of what the button does.  In general, the analysis windows update themselves 
automatically.  If a window is out of date, a red X appears in it.  To update the window, simply click 
on it.  Some windows have a Lock check box on them.  Clicking this control locks the window 
preventing it from updating.  It also saves a copy of the I/O system.  Clicking the Restore button will 
reset the I/O system back to the state when the window was locked.  This allows multiple versions of 
the design to be saved and displayed at the same time. 
 

32 
 


	Tutorial 1: Design of a Pump
	Tutorial 2: Optimization of a Heat Sealer
	Tutorial 3: Dimensional Stack-up Problem
	Tutorial 4: VarTran as a Mathematics Package
	Section 5: Working Your Own Problem



